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RIT Reporting Using Excel Custom Functions

This post is a tutorial providing a comprehensive method to create and update test results to the
excel workbook using the Custom Functions available in RIT-OpenFramework. This post can also
be used as a tutorial for Custom Functions available in GitHub-@harinivas-ganapathy
(h�ps://github.com/harinivas-ganapathy/RIT-OpenFramework/). Here we would see how to use
WriteToExcel function update Test data sheet with test status and also we would use the
examples, project setup to re-execute only failed tests and update their results. We do this in
automation fashion.

For demonstrating the concept and implemention we’ll use the ConvertTemp web service available
from h�p://www.webservicex.net (h�p:// h�p://www.webservicex.net)

Pre-Requisites –

https://harinivasganapathy.wordpress.com/
https://harinivasganapathy.wordpress.com/2016/05/12/rit-reporting-using-excel-custom-functions/
https://harinivasganapathy.wordpress.com/2016/05/12/rit-reporting-using-excel-custom-functions/
https://harinivasganapathy.wordpress.com/author/hganapathy0823/
https://harinivasganapathy.wordpress.com/2016/05/12/rit-reporting-using-excel-custom-functions/
https://github.com/harinivas-ganapathy/RIT-OpenFramework/
http://%20http//www.webservicex.net


(1) Rational Integration Tester (Henceforth will be referenced as RIT)
(2) Internet access to open ConvertTemp WSDL available from
h�p://www.webservicex.net/ConvertTemperature.asmx
(h�p://www.webservicex.net/ConvertTemperature.asmx)
(3) Download ExcelFunction_<version_number>.jar from the GitHub repository –
h�ps://github.com/harinivas-ganapathy/RIT-OpenFramework.git (h�ps://github.com/harinivas-
ganapathy/RIT-OpenFramework.git)
(4) Sample Excel File with Test cases for the ConvertTemp operation. Is also available from the
GitHub repository –

h�ps://github.com/harinivas-ganapathy/RIT-
OpenFramework/blob/master/Examples/ConvertTemp_TestCases_V1.00.xlsx (h�p://
h�ps://github.com/harinivas-ganapathy/RIT-
OpenFramework/blob/master/Examples/ConvertTemp_TestCases_V1.00.xlsx)

Getting Started –

RIT Installation

First we would need RIT installation to proceed further. RIT provides a free Starter Edition for all
learning purpose and acustom with the application. It can be download from IBM’s Continous
Testing Page –

Mac Version –
h�ps://developer.ibm.com/testing/resources/downloading-rational-integration-tester-starter-
edition-for-mac-64-bit/ (h�p:// h�ps://developer.ibm.com/testing/resources/downloading-
rational-integration-tester-starter-edition-for-mac-64-bit/)

Windows Version –
h�ps://developer.ibm.com/testing/resources/rational-integration-tester-starter-edition-
download/ (h�p:// h�ps://developer.ibm.com/testing/resources/rational-integration-tester-starter-
edition-download/)

There is not much of installation procedure for the RIT Starter Edition (RIT SE). Just extract the
downloaded zip or gzip archive. And double clicking the IntegrationTester.app in Mac brings up
the RIT – Starter Edition Splash screen –

 

http://www.webservicex.net/ConvertTemperature.asmx
https://github.com/harinivas-ganapathy/RIT-OpenFramework.git
http://%20https//github.com/harinivas-ganapathy/RIT-OpenFramework/blob/master/Examples/ConvertTemp_TestCases_V1.00.xlsx
http://%20https//developer.ibm.com/testing/resources/downloading-rational-integration-tester-starter-edition-for-mac-64-bit/
http://%20https//developer.ibm.com/testing/resources/rational-integration-tester-starter-edition-download/


(h�ps://harinivasganapathy.files.wordpress.com/2016/05/rit-se-splash-screen_full.png)
Later it would show Welcome window where we will create a new RIT Project

Step 1: Select Create Project from the Welcome Screen

https://harinivasganapathy.files.wordpress.com/2016/05/rit-se-splash-screen_full.png


(h�ps://harinivasganapathy.files.wordpress.com/2016/05/1462796618_full.png)

On the displayed Create New Project screen

Give a name for the project
Specify a location for the project
Click Finish

https://harinivasganapathy.files.wordpress.com/2016/05/1462796618_full.png


(h�ps://harinivasganapathy.files.wordpress.com/2016/05/1462796700_full.png)

Step 2: Switch to the Architecture School selecting it from the Tool bar on the top

(h�ps://harinivasganapathy.files.wordpress.com/2016/05/1462796903_full.png)

Ensure you’re on the Logical View Tab of Architecture School

(h�ps://harinivasganapathy.files.wordpress.com/2016/05/1462796935_full.png)

https://harinivasganapathy.files.wordpress.com/2016/05/1462796700_full.png
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Step 3: Add the ConvertTemp WSDL by selecting wsdl from the Web drop down menu select

(h�ps://harinivasganapathy.files.wordpress.com/2016/05/1462797168_full.png)

Step 4: From the “Create a New Synchronization Resource” – click “New…” to add ConverTemp
Wsdl to the project

(h�ps://harinivasganapathy.files.wordpress.com/2016/05/1462797980_full.png)

 

https://harinivasganapathy.files.wordpress.com/2016/05/1462797168_full.png
https://harinivasganapathy.files.wordpress.com/2016/05/1462797980_full.png


(h�ps://harinivasganapathy.files.wordpress.com/2016/05/1462797798_full.png)
Step 5: Click ‘OK’

Step 6: Give a name for environment – like – SIT, UAT, ProdFIX.
Step 7: Click Next on the “Create a New Synchronization Resource”
Step 8: On the Generate Assets for Operations page – Click Next
Step 9: Click finish on the Summary Page

https://harinivasganapathy.files.wordpress.com/2016/05/1462797798_full.png


(h�ps://harinivasganapathy.files.wordpress.com/2016/05/1462797992_full.png)

Service Component and operation would be created in the Logical View and synchronized in the
Synchronization view

https://harinivasganapathy.files.wordpress.com/2016/05/1462797992_full.png


(h�ps://harinivasganapathy.files.wordpress.com/2016/05/1462798133_full.png)
This completes project setup.

https://harinivasganapathy.files.wordpress.com/2016/05/1462798133_full.png


Loading the Custom Functions

From the the GitHub page download the ExcelFunctions<version>.jar and place it inside the
Functions folder of the Project Home Directory

Switch to RIT Window and select from the Menu bar – Tools -> Functions -> Reload Custom
Functions/Behavior 

To Verify that that Custom Function is loaded select from the Menu bar – Tools -> Functions-
>View All Functions

(h�ps://harinivasganapathy.files.wordpress.com/2016/05/1462798558_full.png)

https://harinivasganapathy.files.wordpress.com/2016/05/1462798558_full.png


Preparing the Test Cases and Test Data Source

After the RIT Project is setup, let’s ensure the test cases are documented. For demonstration I have
sample test cases available in a specific format.

Create a new folder ‘Test cases’ under Project Home.
Download the sample workbook from my GitHub repository in the Test cases folder.

(h�ps://harinivasganapathy.files.wordpress.com/2016/05/1463054935_full.png)

The test case workbook is organized in a way that –

1. It has Unique test ID
2. It has unique test name that can mapped to ALM.
3. It has test execution control flag “Allow_Execution”. The idea of the flag to determine which

tests to execute in RIT from Excel instead of in RIT. This gives a flexibility to control test
execution even without opening RIT when run in Command line mode.

4. It has standard test condition and test steps to describe the purpose of the test.
5. Additionally it has the test Data section. The pupose of having test data part of test case is to

isolate automated test from manual test by feeding test data directly into RIT tests using
parameterization avoids manual test data setup in RIT tests.

6. It has baseline section that is referenced with in RIT to compare the values returned during
execution with the baseline to determine if the test is Passed.

7. It has a result section to write back test result back to this Excel after execution of each step. For
this purpose we will be using the ExcelFunctions available in GitHub RITOpenFramework.

Note:

I have intentionally modified the value of ConvertTempResult for Tests 2, 4 & 6. So that we
could have both results (Passed & Failed) updated in the test sheet and will use it for
demonstrating other two functionality – ReadFromExcel & LookupExcelCol custom functions.

https://harinivasganapathy.files.wordpress.com/2016/05/1463054935_full.png


Build Data source for parameterization

1. Create a new Excel data source by selecting and right click on the operation – ConvertTemp
[ConvertTemperatureSoap] -> New -> Tests Data -> Excel Data Source

2. Give it name like Convert-Temp_Excel_DS
3. Double-Click the newly created Data Source to configure with the Excel workbook downloaded

from GitHub page.
4. Click Browse on the Data source Editor and navigate to the Test case workbook under the Test

case folder.
5. Specify the test sheet name as – “Valid”
6. Ensure “A row of the file contains column names” is checked.
7. Mention 1 in the “Rows to skep before column names”.



8. Click refresh to preview the data from the work book

Test Building in Test Factory

Create Test Cases in RIT 

Switch to Test Factory view in RIT
Select and right click ConvertTemp [ConvertTemperatureSoap] operation from the Test Factory
explorer pane.



(h�ps://harinivasganapathy.files.wordpress.com/2016/05/1463056850_full.png)

Name the test something like – ConvertTemp_Valid to denote this test handles all positive
conditions of the operation. Using this test we will demonstrate WriteToExcel Custom Function
behavior.

Edit to Construct Test using Actions and Parameterization

From the Excel Data Source Tab – after refreshing to preview the Data in the workbook sheet.
Click on ‘Copy Column names to clipboard’ bu�on.
Open the  ConvertTemp_Valid by double clicking in under the Tests folder in Test Factory Pane.

https://harinivasganapathy.files.wordpress.com/2016/05/1463056850_full.png


Open the Tag Editor and click on the Paste Icon to paste the Excel Column headers as Tags to

the test.
Under the Steps tab, in the test editor, select the Test Steps section. And add Iterate Test Data

from ‘Flow’ Menu.
Double Click Iterate Test Data action to configure it.



Click ‘Browse’ to select the excel data source we create before.

Switch to the ‘Store’ Tab and ensure all Excel Column Headers are mapped to the tags in the
Tag Store. There might be tags in Test that shows ‘No Mapping’. It is ok if there is no matching



columns in the Excel workbook. They might be added for other actions in the test.

Purpose of this action is to iterate every row in the excel work book, pick up each test case per
iteration and perform test execution and validation steps.
Next add a decision action from the ‘Flow’ menu.

This action checks if a particular test is to be executed based on how the control flag –
Allow_Execution? is set in test data sheet.

In the true part we’ll add and configure the test action steps requried to trigger the test and
validate it.
In the false part we add a Warning Message that this is not marked for execution and so it is
skipped.
We add a Log action to output a message to the RIT console to display the Test name and
scenario for readability and identifying the message for each test.



In RIT we can capture the overall result of a test, but cannot capture a result of iteration. Hence
we create a Tag ITR_Result to set and use for this purpose.
We begin our test implementation by se�ing the tag ITR_Result as ‘True’. We do this at the start
of every iteration so that result of previous iteration is not carried forward.

Then we add Send Request and Recieve Reply Step.

We add the below XML to the Request

<?xml version="1.0" encoding="utf-8"?><soap:Envelope
xmlns:soap="http://schemas.xmlsoap.org/soap/envelope/"
xmlns:xsd="http://www.w3.org/2001/XMLSchema"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<soap:Body>
<ConvertTemp xmlns="http://www.webserviceX.NET/">
<Temperature>%%Temperature%%</Temperature>
<FromUnit>%%FromUnit%%</FromUnit>
<ToUnit>%%ToUnit%%</ToUnit>
</ConvertTemp>
</soap:Body>
</soap:Envelope>

We add the below XML to the Response



<?xml version="1.0" encoding="utf-8"?><soap:Envelope
xmlns:soap="http://schemas.xmlsoap.org/soap/envelope/"
xmlns:xsd="http://www.w3.org/2001/XMLSchema"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<soap:Body>
<ConvertTempResponse xmlns="http://www.webserviceX.NET/
<ConvertTempResult>%%ConvertTempResult%%</ConvertTempResult
</ConvertTempResponse>
</soap:Body>
</soap:Envelope>

We validate if ConvertTempResult is as per expectation by comparing it with the
%%ConvertTempResult%% tag that comes from the Excel Data sheet. This is done by
mentioning this Tag in the validate tab of the field editor for ‘Equality’.
Additionally configure the response to store the result of ConvertTempResult field into Tag

%%Actual_Value%%
If the Response validation fails the test stops and we won’t be able to access or display or
validate the %%ITR_Result%%. So add a failure path for the response.

Under ‘Validation Failure’ add a Function action to set the %%ITR_Result%% as false.
Add another function action to write that result to Excel worksheet.

writeToExcel("%%PROJECT/ROOT_DIRECTORY%%/TestCases/ConvertTemp_TestCases_V1.00.
xlsx",Valid,regex(add(%%TEST/ITERATION/NUMBER%%,1),"\\d+",1),L,FAILED)



First parameter –
 %%PROJECT/ROOT_DIRECTORY%%/TestCases/ConvertTemp_TestCases_V1.00.xlsx – points
to the Excel workbook file.

Second parameter – Valid – refers to the sheet in excel workbook

Third parameter – regex(add(%%TEST/ITERATION/NUMBER%%,1),”\\d+”,1) – Retrieves the
Iteration number that is used to refer as the row number.

Fourth parameter – L – refers to the Column ‘Result’ in the Excel Workbook.

Fifth parameter – FAILED – refers to the value wri�en to the cell identified by third and
fourth parameter.

Same way we add Function action to include the Custom Function as below –

writeToExcel("%%PROJECT/ROOT_DIRECTORY%%/TestCases/ConvertTemp_TestCases_V1.00.
xlsx",Valid,regex(add(%%TEST/ITERATION/NUMBER%%,1),"\\d+",1),K,%%Actual_Value%%
)

The only difference from earlier function is the fourth and fifth parameter

Fourth parameter – L – refers to the Column ‘Actual_Value’ in the Excel Workbook.

Fifth parameter – %%Actual_Value%% – refers to the value wri�en to the cell identified by
third and fourth parameter. Note that %%Actual_Value%% comes from the actual response
received.

Add another third function action to write the timestamp into the Comments column in the Test
Data sheet.

writeToExcel("%%PROJECT/ROOT_DIRECTORY%%/TestCases/ConvertTemp_TestCases_V1.00.
xlsx",Valid,regex(add(%%TEST/ITERATION/NUMBER%%,1),"\\d+",1),M,%%SYSTEM/CURRENT_
DATE_TIME%%)

The only difference from earlier function is the fourth and fifth parameter

Fourth parameter – M – refers to the Column ‘Comments’ in the Excel Workbook.

Fifth parameter -%%SYSTEM/CURRENT_DATE_TIME%% – refers to the timestamp value
wri�en to the cell identified by third and fourth parameter.

 

As a last step inside the Failure path of the Response add a Fail action, without which even if
the validation fails and Validation Failure Path is executed overall Test Result will be always be



PASSED.
What follows next is the subsequent steps to Receive Reply. Which means actions to be
performed if the Receive Reply validation is successful.
We add a decision to check if the ITR_Result is still true, and if true we add 3 functions actions
in the order
1. Write the status as Passed to Column K in the Test Data sheet
2. Write the Actual Value from the response in Column L
3. Timestamp value in Column M

False part can be left blank as the possible actions that can be included here are already
included within Validation Failure path.

Verifying the Results

Now that test is executed, open the excel workbook from the below location –

%%PROJECT/ROOT_DIRECTORY%%/TestCases/ConvertTemp_TestCases_V1.00.xlsx

Reading value from Excel Workbook



This far we used the WriteToExcel function available from RIT-OpenFramework (available in
GitHub) to update status of every test to a excel workbook. We will continue to use other two
functions – LookupExcelCol() and ReadFromExcel() to re-execute only failed tests from first run.

Remember that we purposefully had a wrong value in the ConvertTempResult column on the test
data sheet so that we see how PASSED & FAILED and wri�en back to the excel worksheet.

we will now demonstrate the use of LookupExcelCol() to check if a specific test is failed by
checking the Result column having FAILED text. Now the tests that had intentionally left
wrong ConvertTempResult is corrected. If Result column has FAILED text we will a�empt to re-
executed the test.

Building the Test

Switch to the Test Factory
In the Test Factory Pane -Right click the test – ‘ConvertTemp_V’ and click ‘Copy’
Right click the test folder and click ‘Paste’
Select the newly created test – ‘ConvertTemp_V (2)’ and right click to select ‘Rename’
Give it a value – ‘ConvertTemp_V-FAILED_TESTS’
The only change we will make it this test is modify the Design logic which checks if
%%Allow_Execution?%% is “Y”.
Double click the decision to edit it.
Add one more test condition by click the ‘Add’ bu�on
Add the below condition to it –

`eq(readFromExcel(%%PROJECT/ROOT_DIRECTORY%%/TestCases/ConvertTemp_TestCases_V1.
00.xlsx,Valid,regex(add(%%TEST/ITERATION/NUMBER%%,1),”\\d+”,1),L),FAILED)`



In the above condition we are using the Excel function readFromExcel() to read the cell content
marked by  row and column.

This function takes 4 parameters –

First Parameter –
 %%PROJECT/ROOT_DIRECTORY%%/TestCases/ConvertTemp_TestCases_V1.00.xlsx 
Identifies the Excel file to read from.

Second Parameter – Valid  identifies the sheet within the excel workbook.

Third parameter – regex(add(%%TEST/ITERATION/NUMBER%%,1) identifies the Row

Fourth parameter – L – identifies the Col

This Function call returns a value and we check this returned value against the Text – FAILED. This
ensures only test which are allowed for execution and failed are executed.

Executing the Test

Save the test.
Run the test by selecting ‘Run’ bu�on from the tool bar or press F5.

From the console log we could see that only tests that failed was executed. Not all tests. Tests that
were not executed just displayed a message – [Warning] Test Not Executed

Opening the excel sheet we could see that FAILED tests were updated as PASSED.



This concludes our tutorial on using Excel Function to update test results to Excel and Read back
from it. The same concept can be used to write values to a separate sheet should we have to
maintain a separate report of execution status. Also remember to log bugs or feature / enhancement
request on Excel Custom Functions on GitHub Issues page (h�ps://github.com/harinivas-
ganapathy/RIT-OpenFramework/issues).

APRIL 24, 2016MAY 3, 2016 ⁄ HARINIVAS GANAPATHY

Rational integration tester – A Guide to Visual
Scripting Experience

The idea of this is post is help any beginners with li�le programming experience, who start with
RIT a fresh, to have a feel of what RIT offers for Scripting to automate Web Services Testing. This
post also portraits RIT usage in a Developers perspective. The post also highlights advanced RIT
features, usage with examples for other RIT users who have medium to advanced exposures.

When you have started with IBM’s Rational Integration Tester product or referred the product
documentation several times while working on a project, you would have come across this
statement, or told by a tutor or had a feeling that

“RIT is a script free automation tool” 

This statement is both true and false. How? is the entire idea of the discussion.RIT offers two kinds
of experience

Basic Beginner Mode

https://github.com/harinivas-ganapathy/RIT-OpenFramework/issues
https://harinivasganapathy.wordpress.com/2016/04/24/rational-integration-tester-a-visual-scripting-experience-2/
https://harinivasganapathy.wordpress.com/2016/04/24/rational-integration-tester-a-visual-scripting-experience-2/
https://harinivasganapathy.wordpress.com/author/hganapathy0823/
https://harinivasganapathy.wordpress.com/2016/04/24/rational-integration-tester-a-visual-scripting-experience-2/


Core Pro Mode

Beginner mode is for novice users who has just started their journey. For such users RIT offers a
Visual Basic kind of experience where there are visual graphical elements for almost every primary
fundamental programming constructs. Like Controls in VB, in RIT they are referred as field actions.
Just like in VB how we drag elements and place them in applications forms, in RIT field actions can
be visually selected and added inside tests with clickable configuration changes. They can also be
repositioned by drag ‘n’ drop.In this fashion it’s true that you can use RIT to test and automate
Web Services application without even writing a single piece of code. However the power of RIT is
its abilities and flexibility in pro-scripting mode.In order to provide a script free experience RIT has
concealed its true power so that it looks simple to use the features and have a test ready in no time.
On first look it would seem so obvious and quite deceiving that RIT is truly scripting free test
automation product. But on the contrary it is a full featured true scripting compatible test
development environment. More over unlike other Testing products which supports either
JavaScript or VBScript, RIT Script engine supports both JS and also any other scripting languages
that support jar extensions like – Python, Groovy etc. It gives great flexibility in selecting the
scripting language to use for automation. In addition to support scripting language RIT also
supports building libraries in Java as Custom Functions that can be used anywhere within the test
script.In the following section we elaborate the different visual elements in RIT that corresponds to
basic programming constructs.

Constants & Variables

Like in any programming language we need named placeholders to store values that can be
processed later by the program, RIT offers Tags to store values in named placeholders that can be
used later in the Tests.

Note:

RIT does not distinguishes between Constant and Variables. It leaves it to test designer to
decide on how to handle. It is up to the designer to ensure the integrity of tags to treat it as
Constant – Just like in JavaScript.

Accessing Constants & Variables

Once Values are stored in Tags they are accessed using a special pa�ern – name of the tag preceded
and succeeded by ‘%%’ like %%variable%%. This way RIT will know to look for a tag named
variable in the tag table.



Note:

To reference Tags inside Function action for legacy – you can use the same pa�ern as above.
However to within ECMASCRIPT use the pa�ern tags[“variable”].

Statement

Statements are the smallest standalone element of a programming language. Likewise Action are
the smallest standalone elements within RIT that can be executed. Statements are made of other
elements like expression, variable & operators, RIT actions include other actions from different
category – Messaging, Flow & General in Starter Edition and Full version additionally has – BPM,
GUI, Map & Stub behaviours.

Operators

RIT is all about functions. Functions are the individual unit to perform computations within RIT
tests. Everything in RIT is implemented as Functions. Operators used in programming statements
are also designed, implemented and made available as Functions from “Select Function” context
menu within action or field editors. Basic operators like addition, subtraction, multiplication and
division are made available as Functions – Add, Subtract, Multiply & Division respectively. Below
is the table showing different operators in a typical programming language and corresponding
functions available in RIT and sample usage example.

Operator Function Usage example Result
Returned

addition add add(expr,expr, …) add(1,1) 2.0

Subtraction subtract subtract(expr,expr) subtract(1,1) 0.0

Multiply multiply multiply(expr,expr) multiply(5,2) 10.0

Division divide divide(expr,expr) divide(10,5) 2.0



Note:

The result of all mathetical functions always returns a decimal value. Most of times we would
need Integer value like used to Iterate. In such case there is no direct way in RIT to convert
decimal into integers.

Data Structures

In general data structures specify ways a programming language provides to store and manipulate
data. Examples – Array, List, HashMap, HashTable. Likewise RIT stores and process data in form
of Tags. Yes, it’s the same Tags we discussed in Section – Constants & Variables. RIT provides a
mechanism to treat a Tag to store single Values as well as multiple values like Array. Tags that store
multiple values are called List Tags. Unlike normal Tags, List Tags cannot be created in the Tag
Store. Instead they have to be configured in the store tab of field editor and selec t the checkbox
“Append to list of values”. This will ensure multiple values are stored in the same Tag like arrays
without existing value. There is also another way to create and add values to list using ECMAScript
which we will discuss in later post.



To access individual items in the List Tag, index numbers are used within set brackets before the
trailling ‘%%’ in the Tag reference. Example %%ListTag[0]%% gives the first value in the list,
%%ListTag[1]%% gives the second value in the list.Index of ListTags can also be referenced using
Other Tags. Example -Create a Tag for index in the Tag store and assign a value of zero inside a
Function action using ECMAScript and remember to use Regex to trim the decimal zero.index=0;
index = regex(index,”\\d+”,1)



Values from the list tag can be accessed using the Index tag in log or field actions using the format –
%%TagName[IndexTagName]%%. Example -%%ListTag[index]%%

Note:

1. Index reference of ListTags always starts with zero.
2. Though List Tags seems like and can be treated like Arrays, actually, inside RIT, they are

implemented as ListArrays in Java. Knowing this li�le secret will open doors to manipulate
them with in ECMAScripts with function steps.

3. When referencing the ListTag using index, during test design, RIT displays it in Red-Error
color to denote as if that is not vailable in the Tag Store. That’s because RIT treats
“ListTag[index]” as a single tag during design. But it will work at runtime. So it is safe to
ignore the color while using index for ListTag.

Control Structures



Traditional programming languages has control structures like if, if-else, switch etc. RIT provides
Decision Flow action to be used and configured like if, if-else, nested if and Switch Statements.. There
is no dedicated switch statement but similar behavior can be simulated using Cascaded decision
action.

if … then …

To make decision in our tests RIT provides decision action. There is 3 parts to this action –

1. Condition – To check for condition based on which either actions inside True or False are
executed.

2. True – If the condition evaluates to true, all statements within ‘True’ part is executed.
3. False – If the condition evaluates to false all statements within ‘False’ part is executed.

To help with comparing values within conditions, RIT provides below condition functions –



Note: There is no if only matching conditional in RIT. Decision action always has true block and the
false block. Though to replicate the if only behavior the false block can be left empty.

The always added false block step can put to productive use. Add a log statement within false
block to check if decision condition evaluated is true or false.Loops

Loop

RIT provides 3 actions to support 3 types of looping support by modern programming languages –

1. For Loop
2. While Loop
3. Loop through data collection

For Loop –

RIT provides Iterate test action that simulates For loop. Number of times the loop to be repeated is
mentioned within the Iteration text field, example 1-5.



Iteration can also be controled by using Tags. Example – 1-%%Counter%%

While Loop



RIT provides ‘Iterate while’ action to simulate While Loop behavior in tests. Iterate while takes one
or more conditions and executes as long as the condition is true. Remember to avoid infinite loop
alter the value of condition variable within the Iterate while action. For Example in below test –
Counter variable is initialized to 0 and a condition ‘counter values less than or equal to 5’ is added
to Iterate while action and the counter value is incremented by 1 after every iteration within the
iterate while action so that the Log statements within it are executed 5 times.

Iterate Data Collections



Like we use to iterate for every value in data collections like in Array, List or Dictionaries in
modern programming languages, RIT provides a mechanism to iterate through values in
ListTags.Example:

Approach 1

STEP 1: Configure Test Data Set as shown below –

STEP 2: Iterate over the test data set created aboveSTEP 3: Use Function actions to read individual
tag values and store them into a tag as List.STEP 4: Use Function to calculate the number of items
in the list using ECMAScript and size() function available in it. And create a new tag “index” to be
used to iterate with in the list. Set the index tag to zero. Remember to trim the the decimal from the
result of the Index.STEP 5: Use Iterate While action to check for the condition index <=ListCount
(No of Items in the listlt(%%index%%,%%ListCount%%)



STEP 6: Within Iterate while use message action to Send request and Receive Reply



STEP 7: Inside of Send request List Tag and Index can be used to tag the input fields like in be
screenshot.





Approach 2:

Another straight forward approach is to avoid calculating the list tag size and using it within
iterate while action. Instead just mention the list tag in the condition field like below – How ever
remember that all steps within the Iterate while action will be repeated for every item in the list
and we have to still use the index tag/value to access the individual elements in the list tag.

BlockBlock is a set of statements grouped together. in C / Java opening and closing curly braces are
used to denote the beginning and end of a block. However RIT provides block as a visual element –
Action Group – with a folder icon image to have test steps grouped and displayed like a tree



structure. Nested blocks are also possible.

Function

Functions in programming languages are series of related steps (instructions) grouped together as
a block to perform a task. RIT provides a visual element named ‘Functions’ to add functions to
tests. This is available from the General Menu. Opening up the Function step provides two modes
to work with them.

1. ECMAScript – allows to add JavaScript snippets to Function step.
2. Legacy – allows using built-in Functions from the library.

Note:

The difference between using ECMAScript and Legacy is that the way Tags should be
referenced. In ECMAScript they can be referenced just with their names or using notation
‘tags[“name”]’. RIT notation of tags – %%TagName%% will not work in ECMAScript and
ECMAScript notation of referencing tag won’t work in Legacy. One another difference is that
functions supported by script engine (like JavaScript or python) will be available to use within
ECMAScript along with build in library but only Functions from built-in library available for
use in Legacy mode. We can of course create Custom Functions using eclipse and add them to
built-in library.

Comments

Adding comments to program helps in documentation and helps readability in programs. Just like
it RIT supports comments by providing Comment action as a visual element that can be added as
steps at point inside the test. Comment actions are not executed when test is run but only added to
aid in readability of the test.



Note

Unlike in programming languages where comments are just text, RIT allows text to be
displayed as HTML Content. This allows to add Font Color and Text Background to signify the
importance of the following test step and add more readability to tests.



Exception Handling

Most modern programming languages provide exception handling to react and respond to errors
that occur during runtime. In RIT there are possibilities that each action step might fail at runtime.
In that case Test stops at the point of error. However we might want to display a message in the
console for troubleshooting that the Test failed due to an Unknown error or specific reason. In such
case we can add a Failure Path to the test action and add a log message to display in console or to a
log file the details of the failed test step.

Note:

When failure path is added to test step and if the test step fails, error message is displayed and
steps within the failure path is executed. After which the execution continues to the next action
following the failed step. Also when failure path is used though error message is displayed in
the console, test result will always show as Passed unless there is a Fail action encountered after
the failure path either as a part of failure path or outside of it. So it is recommended to use Fail
action where ever required to have correct test status.



Assertions

In Programming Languages – assertions are true-false statements which is expected to be always
true for the execution to proceed. If during runtime, executing assertion statement yields false, the
program stops execution at that point and execution does not continue beyond that statement.

Note:

Assertions can be used as if only Decision Actions. but remember when decision fails
executions stops. To have execution continue place the assertion in the action group or add
failure path to it.



I/O Functions

Any programming languages has to deal with data input into the system and output from the
system. Similarly RIT provides a couple of ways to deal with input and output. Provides 4 ways –

1. Write contents into Console
2. Write Contents into File
3. Read Contents from File
4. Read data from User at runtime.

Write contents into ConsoleUse Log action to display text into Console.



File I/O – Write to fileRIT provides log action to write contents into a file. As seen in the example
below the test status is logged to a file. A log message is added in the Tear-down step and
configured to add test name and test result to a CSV file that can be opened outside RIT in a
spreadsheet application.

File I/O – Read from fileReading data from file is not straight forward as writing into it as it
requires two RIT concepts – File Data Source and Tag System.STEP 1: A file Data source should be
created pointing to a CSV file.



STEP 2: Click on “Copy column names to clipboard” from bo�om of the data source tab.STEP 3:
Open tag store



STEP 4: paste the copied tags.STEP 5: Add a Fetch Test Data action and configure it with the
created Test data source.

STEP 6: Edit the Send Request message to read value from the Tags – %%FromCurrency%% &
%%ToCurrency%%



STEP 7: Add log step to display the values read from file



STEP 8: Save and Run

Read data from User at runtime – Like C & Java programming languages have options to read
data entered in console RIT has a test action – “User Interaction” to read data from user at runtime.

Note:

It is a bad idea to read data from user at runtime for testing. In today’s QA environment,
automation is used to avoid any manual interaction. So having user to provide data to test at
runtime is a bad idea. May be can be used while designing a test but not while finalizing the
test.



Library

Every modern programming languages have either built in Library of classes or functions or public
library contributed by open source community. RIT supports both. It has built-in Functions and
also has provisions for third party to contribute on Functions. Refer table above for list of built-in
functions. RIT also provides two ways to build libraries of Function.

1. Build Custom Functions – refer like for ideas on Custom Functions and how to build one –
Demystifying Custom Functions
(h�ps://harinivasganapathy.wordpress.com/2015/09/06/demystifying-custom-functions/).

2. Build JavaScript library – Tutorial on Building and Using JavaScript Library – Coming Soon

String Manipulations

Programs often need to be manipulated to solve specific problems. RIT provides below options and
functions to manipulated strings to deal with test automation requirements.String InterpolationTo
reference values stored in tags in log action or sql action or field actions reference tag name in
format – %%TagName%%

B

String ComparisonUsing the ‘eq’ Function we can check if two strings are same or not.

https://harinivasganapathy.wordpress.com/2015/09/06/demystifying-custom-functions/


Same way we can use ‘ne’ – Not Equal function to check if two strings are equal.

Note:

The strings used as function parameter need not be enclosed inside double quotes. RIT would
automatically consider any parameter as String. Even if we intend to compare numbers and
used numbers as parameter, RIT would treat them as String.



Create String at runtimeWe can use ‘CreateText’ function to generate random text of length
specified as first parameter. Example CreateText(5) would create a random text of size 5 bytes
every time it is executed.



Alternatively we can create a string of certain repeating character using the CreateText function
with the second optional parameter mentioning the repeating character. Example CreateText(15,-)
creates a string of “_______”. Do not include the second parameter value within quotes, if given
RIT considers it as a part of repeating character.



String ConcatenationRIT has a ‘join’ function that concatenate 2 or more string into one. First
Parameter is the delimiter. Example Join (“-“,1,2,3) would return “1-2-3”



Note:For normal style string concatenation without delimiters include empty string for the first
parameter. Example Join (““,1,2,3) would return “123”



Note:If you wish to include space as a part of the String, include it as a parameter within double
quotes.



Ge�ing SubStringRIT does not supports direct Function to get substring from a String. However if
the string is a delimited string it provides getToken Function to retrieve each part of the String.
Example consider the string that represents customer delimited as “FirstName-MiddleName-
LastName-Stree Address-Apt #-City-State-Zip”. to get address part of the customer record delisted
by a hyphen use getToken(“-“,3,”John–Miller-123 Wal Street-456-Iving-TX-34522”, true). Result is
“123 Wal Street”. Note that there is a empty middle name part in the example. Also remember first
parameter is the delimiter char that should be enclosed within double quotes, second one is the
index that starts with “0”, Third one is the actual String from which we are extracting substring
and fourth is a boolean that says if empty part of delimited string should be ignored or not.



if Fourth parameter is false then any empty segment of delimited string is ignored and result is 456.



Note:If a sub String needs to be extracted from non delimited string, use JavaScript substring()
function by selecting ECMAScript from the Script Language dropdown.

Hope this article was useful to get started with scripting in RIT. Do post your questions or
comments.

More to follow on RIT.
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Demystifying RIT Custom Function – Part 3:
Wrapping up for Deployment
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In Part 1 (h�ps://harinivasganapathy.wordpress.com/2015/09/06/demystifying-custom-functions/)
we discussed how to set the requirements ready to build a Custom Function using Eclipse plugin
development framework. In Part 2
(h�ps://harinivasganapathy.wordpress.com/2015/09/10/demystifying-rit-custom-function-part-2-
pu�ing-the-gears-together/) we discussed the architecture of the Function class which is the
backbone of Custom Function and how to develop a Custom Function by extending the Custom
Function. We are also discussed the rules and considerations of creating a Custom Function java
class. In part 3 we will discuss about the requirements and steps to package Custom Function as
pluggable jar and deploying it in RIT.

Steps to deploy Custom Function

(h�ps://harinivasganapathy.files.wordpress.com/2015/09/deployment-steps.png)

Create Extension Points

In order to allow 3rd party Functions added to RIT, IBM has created an extension point by means
of ‘com.ghc.ghTester.functions’. This extension point should be added to the extensions tab in our
project’s Manifest file.

1. Open plug-in’s manifest file by double clicking MANIFEST.MF

https://harinivasganapathy.wordpress.com/2015/09/06/demystifying-custom-functions/
https://harinivasganapathy.wordpress.com/2015/09/10/demystifying-rit-custom-function-part-2-putting-the-gears-together/
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(h�ps://harinivasganapathy.files.wordpress.com/2015/09/new_extionsions_tab.png)
2. In the opened editor select the Extensions tab and click Add.
3. Select com.ghc.ghTester.functions in the New Extension Dialog

4. Click Finish.
5. Extension point and Extension point element are added to the manifest.

(h�ps://harinivasganapathy.files.wordpress.com/2015/09/after-adding-extension.png)

Configure Extension Points

The Extension Point Element has series of fields profiled with default values. Update the values as
per the below as reference –

https://harinivasganapathy.files.wordpress.com/2015/09/new_extionsions_tab.png
https://harinivasganapathy.files.wordpress.com/2015/09/after-adding-extension.png


name:                    Name of the function like formatDate
displayName:        User friendly, readable name that appears in Function menu inside Test function
editor. e.g) Format Date
syntax:                  The syntax of the Custom Function that gives an idea for the user. e.g)
formatDate(date, inputFormat [, outputFormat])
functionClass:       The java class name that we developed in Part 2. Fully qualified name should be
mentioned.
minParameters:     The minimum parameters needed to pass in the function.
maxParameters:    The maximum parameters needed to pass in the function.

(h�ps://harinivasganapathy.files.wordpress.com/2015/09/extension-element-details.png)

Save the manifest file. Next step will fail if not saved before proceeding.

Adding External Jars

This step is optional. It is required if the java class developed in Part-2 uses additional external jars.
Follow these steps to those external jars to the plug-in jar we created above.

1. Add the Jar to the root of the plug-in project
2. Add the jar to the plug-ins project’s build path by –

1. Right-click the project and select Properties > Java Build Path > Libraries.
2. Click Add Jars and browse for the Jar just added under the plug-in project.
3. Close the properties dialog.

3. Open the plug-in’s manifest file for editing and select the Runtime tab.
4. In the Classpath section, click Add and select the Jar that was copied into the project.
5. Save the manifest file.

Generating Plug-in

In the previous steps we created a plugin. Now the plugin has to be packaged with the java class
developed in part 2. Follow the below steps to package the plugin and create a pluggable jar.

1. File > Export.
2. In the Export dialog, select Plug-in Development > Deployable plug-ins and fragments from

the list of exports.
3. Click Next to display the deployable plug-ins and fragment dialog.
4. In the Available Plug-ins and Fragments list, select the plug-in that you want to generate and

export.
5. Select the Directory option and enter a directory location where the plug-in jar will be

generated.
6. Click Finish.

https://harinivasganapathy.files.wordpress.com/2015/09/extension-element-details.png


7. The output of this process is a directory named plug-ins and jar with the name and version
inside the plug-ins directory.

Deploying in RIT

This is the final step in developing and deploying Custom Function. Follow the below steps to
make the Custom Function available under the Functions sub menu inside RIT Tests.

1. Copy the generated plug-in Jar and paste it into the Functions folder under the projects root
folder.

2. In RIT select Tools > Reload Custom Functions so that all added Custom Functions as jar is
available in tests.

3. If needed Select Tools > View All Functions to verify that our function is loaded.

We are finally done. Now the Custom Function can be used like any other Function inside Function
action editor inside RIT.

Disclaimer: The information and Infographics produced here is based on years of experience in
RIT testing and understanding on foundational information provided in IBM Knowledge
Center. The source code re-produced here is taken from the original source and owner – IBM.

SEPTEMBER 10, 2015SEPTEMBER 14, 2015 ⁄ HARINIVAS GANAPATHY

Demystifying RIT Custom Function – Part 2:
Putting the gears together

In Part 1 (h�ps://harinivasganapathy.wordpress.com/2015/09/06/demystifying-custom-functions/)
of the series, we discussed the list of pre-requisites and steps to set them up to begin developing
Custom Functions. In Part 2 we would explore in detail about understanding the architecture of the
Function class which is the backbone for any Functions in RIT.

Function Class Architecture

Any Function whether it is built-in or custom made – they are subclasses of Function Class
available in ‘com.ghc.ghTester.expressions’ package that we added to the target platform and manifest
dependencies in Part 1 (h�ps://harinivasganapathy.wordpress.com/2015/09/06/demystifying-
custom-functions/). It is important to understand the design of this Class because RIT lays down
few rules that we have to follow for it to recognize, understand, load and execute our Function.
Function Class has many methods, but three of them are very important and significant – the
public constructor, create and evaluate method.

https://harinivasganapathy.wordpress.com/2015/09/10/demystifying-rit-custom-function-part-2-putting-the-gears-together/
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public Constructor :   The way functions are designed in RIT mandates a default public constructor
with no parameters. This is needed for loading our Custom Function class into RIT JVM. We don’t
need to add any computation inside this constructor. However it can be used to initialize instance
variables.

create (int, vector) :    This is a factory method that creates the instance of the particular
Function with specific arguments we send during runtime. This method is invoked when RIT
encounters the Custom Function syntax while evaluating a function action in tests. It is the
responsibility of the create function to create, initialize and instantiate the specific Function object
with matching parameters mentioned in the Function call in tests.

Note that we can design and implement more than one Custom Function inside single Java
Class file. And so it is the responsibility of the create method to initialize and instantiate the
right Function with right parameters.

evaluate (Object) :      This is the actual method that performs the computation of the Function we
design and considered brain of our Custom Function Class. It is invoked by RIT after create method
returns the second Function instance.

Rules of extending Function Class

1. Custom Function class should have a public default constructor.
2. Custom Function class should override create (int, vector) method.
3. Custom Function class should evaluate (Object) method.

Flow of Control

Step 1: When RIT starts up, it creates an instance of our Custom Function class using the default
constructor and loads it to RIT JVM. For our reference we call it Instance 1. Once the Function
successfully loaded, it will be available for us to use inside function action in tests.

Step 2: When RIT encounters the Custom Function syntax, while evaluating the function action in
tests, it invokes the create method of the Instance 1 and sends two arguments in the call – (1)
number of arguments in test function call as int and (2) all the arguments as a vector. Create method



then creates another instance of the Custom Function and initializes it by calling the constructor
with matching parameters based on the arguments received.

Step 3: Then it returns the newly created instance back to RIT with all data and parameters. For our
reference we call this instance as instance 2.

Step 4: After receiving the instance 2 Custom Function object, RIT invokes the evaluate method of
Instance 2 object and sends an Object as argument.

Step 5: On receiving the call, evaluate method has to discover the String data wrapped as an
Function during the constructor call and assign it to the local variables for processing. Based on the
received arguments, the evaluate method decides what to do. After performing all the
computations it sends back the computed result back to RIT.

(h�ps://harinivasganapathy.files.wordpress.com/2015/09/blog_rit_1.png)

Understanding using Code

Let us understand the architecture and flow of control we learnt so far by reviewing a sample code.
For this purpose i have taken the example provided by IBM in its product documentation so it
would easier when folks use the product documentation for further reference.

https://harinivasganapathy.files.wordpress.com/2015/09/blog_rit_1.png


(h�ps://harinivasganapathy.files.wordpress.com/2015/09/code_control_flow1.png)

Understanding the notion: ‘Everything is Function’

If you would take another look at the code, if not already noticed, you would realize that
everything inside the Custom Function class either takes Function as argument or returns a
Function object. Even the data members are type Function. The vector of parameters passed are
also casted as Functions. Hence to use them for processing inside evaluate method the
parameters as Function must be evaluated to discover the String value. For this purpose we use
evaluateAsString(Object) method available in the Function Class.

Key Items for Consideration

1. There should be a public no argument constructor.

2. Class level variables should be created for each possible arguments the Custom Function is
designed to take and each of the variables should be declared as type Function.

3. Class level Function variables must be initialized inside the corresponding constructor with
parameters. Remember each parameters in Constructor are Functions so that they can be assigned
to corresponding Class Variables.

4. There should be as many constructors with possible arguments a Custom Function call can have.
For e.g. if a Custom Function is designed to take 2 or 3 or 4 arguments, then there should be 3
constructors with 2, 3 & 4 arguments respectively, so that create method would be able to use and
instantiate the second instance. Or like in the IBM example single constructors can be used,
however optional parameters must be evaluated and check for NULL like below –
Function outputFormat = null;
 if (size == 3) {
     outputFormat = (Function) params.get(2);
 }

https://harinivasganapathy.files.wordpress.com/2015/09/code_control_flow1.png


5. create method should return only a new Instance of Custom Class with the String
arguments stored as vector casted as Function before invoking corresponding constructor.

6. In evaluate method the actual String passed in Custom Function call in RIT test must be retrieved
from the Function variables using evaluateAsString method available in the Function class.

7. evaluate method should return a String.

Now that we have got our core Custom Function Java Class ready, next step is to package it as a
plug-in Jar and import it in RIT. We cover just these steps in our final Part – 3.

Continue to Part 3
(https://harinivasganapathy.wordpress.com/2015/09/13/demy
stifying-rit-custom-function-part-3-wrapping-up-for-
deployment/)

SEPTEMBER 6, 2015SEPTEMBER 17, 2015 ⁄ HARINIVAS GANAPATHY

Demystifying RIT Custom Function – Part 1:
Gear up

I had a hard experience reading through the product documentation from IBM on creating Custom
Functions in Rational Integration Tester (RIT). After re-reading many times finally got hold of the
concept behind extending Functions in RIT. So just thought of sharing my learning in the hope that
it would make understanding the underlying concepts more easier than reading through the
documentation over and over again.

What is a Function?

Let us take a moment to understand the idea of Function and later dive more deep into creating
one our own that can be plugged into RIT. Generally a function is a reusable block of code that
takes one or more input (technically called parameters) from the test, performs some action (that is
abstracted to test designer) on the input data and provides an output that can be used any where
within an RIT test case later. RIT provides syntax and required parameters for using every function
within its function editor – both legacy and ECMAScript. RIT supports two types of Functions –

Built-in Functions – like – xpath, round, eq, gt, floor, mod, add, subtract – that are designed by
IBM and shipped with every instance of RIT Product.
Custom Functions – RIT User (technically test designer) created Functions that meets his / her
custom needs. RIT test designer creates his own for use in more than one place.
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What is a Custom Function?

Before taking a detailed view of Functions let us review what is a Custom Function at an high
abstracted level. A Custom Function is a Function that is designed, implemented and used by RIT
user (tester or test designer) and not that provided by IBM by default. In addition to the built-in
Functions provided by RIT, it also provides capability to create additional Functions by test
designers to meet custom needs and testing requirements that can be reused across RIT tests &
projects within an organizations.

Function is actually a Class provided by IBM so that it can be extended to create  Functions
tailored and customized for testers requirement. Hence the name – Custom Function. More about
this in Part 2

Steps to develop Custom Functions:

Like every other programming model, developing Custom Functions involves 3 steps with each
steps involving more additional steps.

1. Design & Develop
2. Configure
3. Integrate

(h�ps://harinivasganapathy.files.wordpress.com/2015/09/process-ladder_2.png)

Step 1 – Design & Develop

First step is more critical and complex part as it covers the core purpose, design and
implementation of the Function. It involves 3 additional steps –

Step 1.1: Prepare yourself and complete initial setup.

Drafting a logical design of the function –

From test designer (end-user of the completed plugin) perspective – Function is a black box, because
he doesn’t need to know the Function’s Implementation – how it process the input to produce the
output. All a Function says is “Give me, so and so input and i will do some computation with the

https://harinivasganapathy.files.wordpress.com/2015/09/process-ladder_2.png


input to convert it and give you a certain output.

So from Function designer perspective he has to have answers to below questions to start creating a
Custom Function.

1. What’s the purpose of it?
2. What are the minimum and maximum parameters needed to perform its indented operation?
3. What are the Parameters?
4. What should be its output?

Once answers to these questions are collected, we then move into the tools / software requirements
–

Step 1.2: Software Requirements

1. RIT installation
2. Eclipse installation – with PDE (Plugin Development Environment Support)

Step 2: Create Plugin Project in Eclipse

RIT is built on top of Java and Eclipse Platform. Hence it has ability to accept plugins developed &
packaged as eclipse plugins.

To create an Eclipse Plugin Project:

1. Start / Open Eclipse Project
2. Create an Eclipse Workspace
3. Select New > Project from the File menu. The New Project wizard is displayed.



(h�ps://harinivasganapathy.files.wordpress.com/2015/09/project_selection.png)
4. Select Plug-in Development > Plug-in Project, then click Next.

(h�ps://harinivasganapathy.files.wordpress.com/2015/09/plugin_project-selection-
window.png)

5. When the Plugin-in project page is displayed enter a project name, then click Next.
6. Complete the Content Page as per the below information and Click ‘Finish’

Plug-in ID :            Plugin ID is to help RIT differentiate among other plugins created by users.
Plug-in Version:    Plugins can also have incremental features & bug fixes and each can have a
version.
Plug-in Name:       A short user friendly name that describes the Function’s purpose.
Plug-in Vendor:  Name of the organization or department within organization that owns the plug-
in.
Plug-in Options:   Disable both options.
Rich Client 
Application:          Select ‘No’ for this options.

https://harinivasganapathy.files.wordpress.com/2015/09/project_selection.png
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(h�ps://harinivasganapathy.files.wordpress.com/2015/09/plugin_prop_page.png)

Eclipse opens up the Manifest File associated with the Plug-in development.

(h�ps://harinivasganapathy.files.wordpress.com/2015/09/manifest_file.png)

Step 3: Se�ing up the dependencies to RIT

Since we are developing an plug-in that will be used in RIT Environment, We have to let Eclipse
know that our plug-ins Target environment is RIT. So that all libraries needed for extending RIT is
available during plugin development. This is done by adding below RIT plug-ins as Target
Platform in Preferences.

1. Go to Window > Preferences > Plug-in Development > Target Platform

https://harinivasganapathy.files.wordpress.com/2015/09/plugin_prop_page.png
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(h�ps://harinivasganapathy.files.wordpress.com/2015/09/target_platform_page_1.png)
2. Click Add to an Target Definition to let eclipse know that the plug-in we are developing is for

RIT.
3. In the following Target Definition Dialog, select “Nothing: Start with an empty target Definition”

and Click “Next >“

(h�ps://harinivasganapathy.files.wordpress.com/2015/09/target_definition.png)
4. In the displayed Target Content page Give a meaningful name like RIT to signify the Target

definition is related to RIT environment and Click Add to proceed.

(h�ps://harinivasganapathy.files.wordpress.com/2015/09/targetcontent.png)
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5. In the displayed Add Content page select Directory and click Next > to proceed.

(h�ps://harinivasganapathy.files.wordpress.com/2015/09/add-content.png)
6. In the Add Directory page click Browse and navigate to the IBM® Rational® Integration

Tester installation folder (C:\Program Files\IBM\IBMIMShared\Plugins, by default) and click
Next >.

(h�ps://harinivasganapathy.files.wordpress.com/2015/09/add-directory.png)
7. The Target Content page will now show the location we added and plugin available in the

location. Click Finish to Close this page.
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(h�ps://harinivasganapathy.files.wordpress.com/2015/09/target_content_loc.png)
8. All of the plug-ins in the Rational Integration Tester folder is read and listed in the Plug-ins tab

of the Target Platform preferences.
1. com.ghc.*
2. com.greenhat.*
3. com.ibm.greenhat.*
4. com.ibm.rational.rit.*

(h�ps://harinivasganapathy.files.wordpress.com/2015/09/preference_target_platform.png)
9. Click OK to close the Preferences dialog.

Step 4: Se�ing the dependency in the manifest

1. From the Project explorer > double click META-INF > MANIFEST.MF
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(h�ps://harinivasganapathy.files.wordpress.com/2015/09/manifest_dependencies.png)
2. In the opened editor select the Dependencies tab and click Add next to Imported Packages.
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3. In the displayed  The Package Selection dialog filter using *.expressions wildcard and select

com.ghc.ghTester.expressions and click Ok.
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4. Save the Manifest file

Ok we have got all our initial setup ready. This concludes our first part of the journey together.
Follow me into the next part of the trail. On our way we’ll understand the foundational design of
Function Class and implementation details of our Custom Function.

Continue to Part 2
(https://harinivasganapathy.wordpress.com/2015/09/10/demy
stifying-rit-custom-function-part-2-putting-the-gears-
together/)

Happy Reading!

Blog at WordPress.com.
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